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Part Names

Front

No. Name Function overview

Maintenance cover
Remove when performing manual cleaning.

P. 72Manual Cleaning

Front cover Keep this cover closed except when necessary, such as when
loading media.

Print-head carriage The print heads and blade are inside this carriage.

[POWER]Key Switches the printer on and off.

Cartridge slots The location where ink cartridges are installed.

Pinch roller These clamp the media when the loading lever is moved to the
front of the machine. The right pinch roller is fixed in place.

Platen
This is the path over which the media passes. A suction fan that
keeps the media from coming loose and a print heater that helps
fix the ink are built in.

Media clamp These keep the media from coming loose and prevent fuzz on the
cut edge of the media from touching the print heads.

Blade protector This protects the tip of the blade during cutting.

Grit roller These rollers feed out media toward the front of the machine.

Introduction
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Rear

No. Name Function overview

Loading lever Operate this when you load media.

USB connector -

Main power switch -

Power-cord connector -

Left media guide Use this guide when loading media. This guide is on the "Left"
when viewing the printer from the front.

Right media guide Use this guide when loading media. This guide is on the "Right"
when viewing the printer from the front.

Waste cartridge -

Introduction
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System Configuration of This Machine

"VersaWorks 6" is written as "VersaWorks" in this manual.

System configuration

The following combination of devices and software can be used to generate output.

• Commercially available application software + VersaWorks + BN-20D driver

Commercially available ap-
plication software

Verified application software

• Adobe Illustrator CC 2015 or later
• CorelDraw X7 or later

VersaWorks
This is a highly functional software RIP (Raster Image Processor) that can be used to
load printing data and configure diverse printing settings.
For more information, see "VersaWorks Installation Guide."

BN-20D driver Driver software that is needed to output printing data from a computer to the ma-
chine.

Utility

Software that is needed to operate the machine. The major functions are shown below.

• Display of messages and error messages
• Adjustment function
• Management of ink remaining amount
• Maintenance function

 RELATED LINKS 

・  P. 10Opening the Utility Window/Exiting Utility

・ VersaWorks Installation Guide

Introduction
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Opening the Utility Window

Click  (the Utility icon) in the notification area. (Or, right-click , and then click [View/Hide].)

The Utility window is displayed.

Utility is "resident software" that is always running. To hide the window, click  in the upper-right corner of the
window or click [Close]; Utility will not terminate.

If  is not displayed in the notification area, start Utility from the Windows Start menu.

MEMO

Starting Utility from the Windows [Start] menu

Windows 11

From the Start menu, click [BN-20 Utility for Windows]>[BN-20 Utility for Windows].

Windows 10

From the Start menu, click [BN-20 Utility for Windows]>[BN-20 Utility for Windows].

Opening the Utility Window/Exiting Utility
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Exiting Utility

Right-click  (the Utility icon) in the notification area, and then click [End].

This exits the utility.

Opening the Utility Window/Exiting Utility
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Windows 11

From the Start menu, click [VersaWorks]>[VersaWorks].

Windows 10

From the Start menu, click [VersaWorks]>[VersaWorks].

 RELATED LINKS 

・ VersaWorks Help

Starting VersaWorks
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With VersaWorks running, click [Help]>[Show Help] from the menu.

Windows 11

From the Start menu, click [VersaWorks]>[VersaWorks Help].

Windows 10

From the Start menu, click [VersaWorks]>[VersaWorks Help].

 RELATED LINKS 

・  P. 12Starting VersaWorks

How to Open the VersaWorks Help
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Types of Media

In this manual, the paper used for output is called "media." The two main types of media used in this ma-
chine are shown below.

• Roll media: Media wound onto a paper tube

• Sheet media: Media not wound onto a paper tube such as standard-size media

Various paper types of roll media and sheet media are selectable according to your purpose. For detailed
information about each media, contact your media supplier. Media can also be purchased from our web-
site.

 RELATED LINKS 

・ https://www.rolanddg.com/

Usable Media

This machine cannot print on every kind of media. Before selecting media, be sure to perform trial print-
ing to check whether satisfactory output quality is obtained.

Size

Usable Media

Width *1 • 150 to 170 mm (5.9 to 6.7 in.)
• 200 to 235 mm (7.9 to 9.3 in.)
• 287 to 322 mm (11.3 to 12.7 in.)
• 348 to 383 mm (13.7 to 15.1 in.)
• 393 to 429 mm (15.5 to 16.9 in.)
• 439 to 474 mm (17.3 to 18.7 in.)
• 487 to 515 mm (19.2 to 20.3 in.)

Cuttable media thickness*1 Max. 0.22 mm (8.66 mil; depending on the media composition)

Maximum media thickness (including back-
ing paper)*1

When only printing: 1.0 mm (39.4 mil)
When performing cutting: 0.4 mm (15 mil)

Maximum roll outer diameter 150 mm (5.9 in.)

Paper tube (core) inner diameter 76.2 mm (3 in.) or 50.8 mm (2 in.)

 

*1 Applies to both roll and sheet media
 

Maximum Roll Weight

6 kg (13.23 lb.)

Other Conditions

Media such as the following cannot be used.

• Media whose end is attached to the paper tube (core)

• Media that is severely warped or that has a strong tendency to reroll

• Media that cannot withstand the heat of the media heating system

• Media whose paper tube (core) is bent or crushed

• Media that bends under its own weight when loaded

• Media on a sagging roll

• Media that is rolled unevenly

About the Media Used
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The following four output methods are available for this machine.

Printing (Only) Printing using ink. It is also called "Printing Only" to distinguish from "Printing and Cutting."

Cutting (Only) Cutting using a blade such as for seal die cutting. It is also called "Cutting Only" to distinguish from
"Printing and Cutting."

Printing and Cutting Printing method in which printing is followed by cutting. If output data that contains both printing
and cutting information is sent to the printer, the cutting operation starts after printing finishes.

Crop-Cut
Output method using "Crop Marks" to align the printing and cutting results. If you are printing on
the media, removing it so it can be laminated, and then reloading the media in the machine to cut
it, use the crop marks to align the media.

Important Points During Use

Use the machine periodically

We recommend using the machine at least once a week. If left unused for a long period of time, the ink
may settle, resulting in unstable discharge (and nozzle clogging). Any dry ink will need to be discharged.

Four Different Output Methods
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Precautions When Operating the Power Supply

Make sure that the main power is on at all times
Never switch the main power off. Continuous power on allows the automatic maintenance function to work periodically.
Failure to ensure automatic maintenance will result in a malfunction of the machine, such as damaged print heads.
During operation, never unplug or switch the main power off.
During operation, if the main power is switched off, or unplugged, the print heads may be damaged. The sub power
switch must always be turned off before the main power is switched off. To turn off the sub power switch, press and
hold down the [POWER] key. If accidentally the main power is switched off, immediately switch the main power and sub
power ([POWER] key) back on again.

IMPORTANT

Switching the Power On

Remove any loaded media or switch off the sub power when printing is not being performed.
The continued application of heat at a single location may cause the release of toxic gases from the media or pose a
fire hazard.

WARNING

Procedure

1. Close the front cover.

2. Switch the main power on.

3. Press the [POWER] key.

When the [POWER] key indicator changes from flashing to steady, startup is completed.

Switching Power On and Off
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Switching Power On and Off
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Switching the Power Off (Sub-power Off)

Procedure

1. When output is completed, press and hold down the [POWER] key for one second or more.

When the [POWER] key light is off, the power is off.

2. Push the loading lever backward.

Even if you are not going to switch the power off when the machine is not in use, make sure the
loading lever is moved to the rear.

Sleep Mode (Power-saving Feature)

This machine is provided with a power-saving feature that switches to a low-power "sleep mode" when
about 30 minutes pass with no operation.

The [POWER] key's indicator flashes slowly when the machine is in sleep mode. Operating the [POWER] key
or sending printing data from the computer when media is loaded in the machine restores it to the normal
mode.

Switching Power On and Off
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This section describes operations when printing only.

Refer to Cutting / Printing and Cutting(P. 40), Performing Printing and Cutting Separately(P. 47).

Step 1: Loading Media

Loading Roll Media

Procedure

1. Move the left media guide to the left edge.

(1) Push the loading lever ( ) backward.

(2) Move the left media guide ( ) to the left.

2. Attach the media flange ( ) to one end of the media bar ( ).

Insert the side of the media bar with a hole ( ) into the media flange. When loading roll media
with a 3-inch paper tube inner diameter, attach the media flange with ( ) on the inside. When
loading roll media with a 2-inch paper tube inner diameter, attach the media flange with ( ) on
the inside.

3. Insert the mounting pin ( ) into the media flange and the media bar, and then secure them with the pin
( ).

Printing

20  Basic Operations



4. Load the roll media onto the media flange.

Install the roll media so there is no gap between it and the media flange.

Place the secured media flange at the bottom, so that the media feeds in the clockwise direction when viewed
from above. You cannot load the media correctly if the feed direction is incorrect.

MEMO

5. Place the roll media loaded onto the media bar on the printer.

Press both ends of the media bar into the grooves at the back of the printer while making sure the
media does not become loose.

Printing
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6. Adjust the loaded position of the roll media.

(1) Move the roll media to the right so the media flange ( ) touches the right media guide ( ).

(2) Slide the left media guide ( ) and press it against the media flange.

7. Pass the media through the printer.

Pull the media straight to keep it taut, and then pass it beneath the media clamps ( ).

Not OKOK

The pinch rollers cannot be moved directly by hand. Move them with the media guide.
Attempting to forcibly move these rollers may result in injury.

CAUTION

8. As shown in the figure, pass the media under the front cover and pull the media out the other side.

Printing
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9. Start initial operation.

(1) Make sure the left media guide ( ) is pressed against the media flange.

(2) Close the front cover ( ).

(3) Pull the loading lever ( ) forward.

Pull the loading lever forward to start initial operation. When the [POWER] key indicator
changes from flashing to steady, initial operation is complete.

Printing

Basic Operations 23



Loading Sheet Media

Procedure

1. Move the left media guide to the left edge.

(1) Push the loading lever ( ) backward.

(2) Move the left media guide ( ) to the left.

2. Install the sheet media.

(1) Move the media to the right so it touches the right media guide.

(2) Slide the left media guide so it touches the media.

(3) Pass the media through the printer.

Pull the media straight to keep it taut, and then pass it beneath the media clamps ( ).

Printing
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Not OKOK

The pinch rollers cannot be moved directly by hand. Move them with the media
guide.
Attempting to forcibly move these rollers may result in injury.

CAUTION

3. As shown in the figure, pass the media under the front cover and pull the media out the other side.

4. Start initial operation.

(1) Make sure the left media guide ( ) is pressed against the media flange.

(2) Close the front cover ( ).

(3) Pull the loading lever ( ) forward.

Pull the loading lever forward to start initial operation. When the [POWER] key indicator
changes from flashing to steady, initial operation is complete.

Printing
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Printing
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Step 2: Bidirectional Adjustment

Perform this adjustment in the following situations. You do not need to perform this adjustment in other
situations. Proceed to Step 3: Printing Tests and Normal Cleaning(P. 29).

• When using this machine for the first time

• When changing the media to use

What are bidirectional printing and bidirectional adjustment?
This machine can perform "Bidirectional Printing," which means that the print heads print when moving in both direc-
tions. Bidirectional printing offers the advantage of being able to shorten output times, but subtle misalignment occurs
during the outbound and return passes. The operation to correct these misalignments is called "Bidirectional adjust-
ment."

MEMO

Bidirectional printing occurs when "Draft" is selected for the print quality in VersaWorks. For details on how to set the
printing quality, refer to [Output Settings]>[Setting the Printing Quality] in the [VersaWorks Help].

MEMO

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. Click [Bidirectional adjustment].

3. Click [Test Print].

A test pattern is printed.

Printing
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4. Follow the on-screen instructions and enter the value for [New Value].

5. Click [Apply].

The value in [Current Value] changes to the entered value.

6. Click [Close].

 RELATED LINKS 

・ VersaWorks Help

Printing
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Step 3: Printing Tests and Normal Cleaning

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. Click [Check Nozzle Condition].

3. Click [Test Print].

A test pattern is printed. Follow the on-screen instructions to check for nozzle drop-out.

• Nozzle drop-out is present. -> Proceed to step 4.

• No nozzle drop-out is present. -> Click [Close] to finish the procedure.

4. Select the [Normal Cleaning], and then click [Go].

Normal cleaning starts.

Printing
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5. Check for nozzle drop-out again.

If the nozzle drop-out is not fixed, perform [Normal Cleaning] again. For information about [Medi-
um Cleaning] and [Powerful Cleaning], refer to the topic shown below.

If nozzle drop-out occurs in two or three locations after cleaning, the output quality may not be affected.
Print the actual printing data and use the machine as-is if you can confirm that there are no problems.

MEMO

 RELATED LINKS 

・  P. 70Medium/Powerful Cleaning

Printing
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Step 4: Correcting the Media Feed

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. Click [Calibrate Sheet Feeding].

3. Click [Test Print].

A test pattern is printed.

4. Follow the on-screen instructions and enter the value for [New Value].

The current correction value (A) is that of the figure indicated by " ." Select the value to make
the gap (B) and overlap (C) between the upper/lower squares smallest. In the case of the following
figure, select "−1.05%." When you cannot choose between two sequential numbers, specify a value
that is between them.

Printing
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5. Click [Apply].

The value in [Current Value] changes to the entered value.

6. Click [Close].

Printing
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Step 5: Starting Print Output

Procedure

1. Prepare the print data.

2. Output the print data.

Output the printing data from VersaWorks.

Refer to [Basic Operations for Output] in the [VersaWorks Help].
VersaWorks Help

3. When the output is complete, separate the media.

Output Is Not Possible in These Situations

• The machine does not run when a cover (front or maintenance) is open.
• The machine does not complete startup and accepts no operations until the heater reaches the specified

temperature.
When the ambient temperature is low, the heater is slow to warm up. Use the machine in an environment
where the temperature is 20°C to 32°C (68°F to 89.6°F).

• Output is not performed when the [POWER] key's indicator is not lit. After loading the media, lower the
loading lever. When the [POWER] key's indicator flashes, no operation except for canceling output is ac-
cepted.

• If you send output data in a state where there is no ink left, a warning buzzer will sound and the machine
will pause. A message indicating that ink has run out is displayed in the Status field in the Utility window.
When the ink cartridge is replaced with a new one, output starts.

Points that must be observed

• Never open a cover (front or maintenance) while output is in progress. Doing so interrupts printing.
• When you are performing printing, clamp the edges of the media with the media clamps. Otherwise, the

edges of the media may warp and catch on the print heads.
• During output, do not touch the media. Doing so may obstruct the media feed or cause the media to rub

against the print heads, which may result in a paper jam or damage to the heads.
• Keep the loading lever raised when the machine is not in use.

When not using the machine, remove any media and store it in a suitable environment.

• If the machine is left with the media loaded, the media may be damaged, which may adversely affect
printing. When not using the machine, remove any media and store it in a suitable environment.

IMPORTANT

 RELATED LINKS 

Printing
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・ VersaWorks Help

Printing
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The output-start location is always the point shown in the figure below.

Printing area

Right pinch roller

Output-start location

Blade protector

A 1.4 mm (0.06 in.)

B 5 mm (0.2 in.)

Output-start Location
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Canceling Output from the Printer

Procedure

1. Press and hold down the [POWER] key for one second or more during output.

Output is canceled. You cannot resume output from the point it was canceled.

2. Press the [POWER] key to turn the machine on.

This operation does not cancel standby output data on the computer. Follow the steps below to
cancel data that is still on the computer.

 RELATED LINKS 

・  P. 37Canceling Output from the Computer

Stopping Print Output
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Canceling Output from the Computer

Procedure

1. Open the [View devices and printers] screen.

• Windows 11

a. Click [Start]>[All Apps]>[Windows Tool].

b. Click [Control Panel].

c. Click [View devices and printers].

• Windows 10

a. Click [Start]>[Windows System]>[Control Panel].

b. Click [View devices and printers].

2. Double-click the BN-20D icon.

3. Click [Printers]>[Cancel All Documents].

Depending on the computer data transfer status, it may be too late to cancel output. In this case,
you need to cancel output from the printer.

Stopping Print Output
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Adjusting Cutting

Adjust the cutting conditions to obtain clear cutting lines. Make adjustments to match the media thick-
ness.

When making these adjustments, use adhesive media that can be cut.

MEMO

Procedure

1. Load the media to be cut.

P. 20Step 1: Loading Media

2. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

3. Click [Cut Adjustment].

4. Click [Test Cut].

A cutting test is performed.

Cutting / Printing and Cutting
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5. Enter the [Cut Force][Cut Speed][Cut Times].

[Cut Force]

This is the force of the blade during cutting. If this force is too strong, the blade cuts into the
backing paper. (Default setting: 50 gf)

[Cut Speed]

This is the speed of the blade during cutting. If this speed is too fast, the cutting line will be
crooked. (Default setting: 15 cm/sec.)

[Cut Times]

This is the number of times to cut the same location. If cutting is not possible even after adjust-
ing the force and speed of cutting, increase the number of cuts. (Default setting: 1)

Check item Result Setting item Adjustment

Check the shape. The cut shape is distorted. [Cut Speed] Reduce

Peel off the circle.
The square also peels off. [Cut Force] Increase

Some uncut areas remain. [Cut Speed] Reduce

Peel off the square.

The blade leaves faint traces on the backing
paper.

[Cut Force]

No change

The blade trace is indistinct. Increase

The blade trace is too deep and cuts into the
backing paper. Reduce

6. Click [Apply].

Repeatedly perform [Test Cut] and make adjustments until the appropriate adjustments are ob-
tained.

7. Click [Close].

Cutting / Printing and Cutting
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Accurately Adjusting the Cutting-in Amount

When you want to perform accurate and fine adjustment of the cutting-in amount ( ), such as when cut-
ting media with thin backing paper, you can obtain good results by adjusting the tip of the blade. Turn the
cap portion of the blade holder to adjust the amount of blade extension. Each indicator tick corresponds
to 0.1 millimeters, and adjustment for 0.5 millimeters can be made by rotating the cap one full turn.

Note that making the amount of blade extension too small may cause the tip of the blade holder cap to
touch, and may soil and damage the printed surface. It's important to be especially careful about this
when you're using media that has poor ink adhesion properties.

The amount of blade extension ( ) is 0 mm ( ) at minimum and 2.5 mm (98.4 mil) ( ) at maximum.

Rough Estimate for the Amount of Blade Extension

Set the amount of blade extension ( ) to an amount that is the sum of the thickness of the material por-
tion ( ) and half ( ) the thickness of the backing paper ( ).

Cutting / Printing and Cutting
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Printing and Cutting Adjustment

When performing both printing and cutting, adjust and align the printing and cutting positions. Depending
on the media thickness, sometimes printing and cutting positions are very slightly out of alignment. We
recommend that you make corrections to match the media you are using.

When making these adjustments, use adhesive media that can be cut.

MEMO

Procedure

1. Load the media to be cut.

P. 20Step 1: Loading Media

2. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

3. Click [Print and Cut Adjustment].

4. Click [Print and Cut Pattern].

A test pattern is printed.

Cutting / Printing and Cutting

Optimizing the Output Quality 43



5. Follow the on-screen instructions and enter the corrected values for [New Scanning Value] and [New
Feeding Value].

6. Click [Apply].

The values in [New Scanning Value] and [New Feeding Value] change to "0."

7. Click [Close].

Cutting / Printing and Cutting

44  Optimizing the Output Quality



Creating Data for Cutting/Printing and Cutting

Verified application software for creating drawings

• Adobe Illustrator CC 2015 or later

• CorelDraw X7 or later

Procedure

1. Create the printing data using application software for creating drawings.

For details on the basic operations of this application software, refer to its documentation.

2. Add cutting lines to the printing data to create the cutting data.

For details on how to create cutting data, refer to [Performing cutting]>[Creating cutting data] in
the [VersaWorks Help].

 RELATED LINKS 

・ VersaWorks Help

Cutting / Printing and Cutting
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Cautionary Notes on Making Output with Cutting

Points to Note When Cutting Only

For roll media, let the media hang down to the rear before outputting.

When using roll media and only performing cutting, let the media hang down to the rear of the machine.
This prevents motor errors and the roll falling from the machine due to the media being pulled with exces-
sive force.

When you are performing printing and cutting, allow the ink to dry sufficiently before starting cut-
ting.

You can set the time for the printer to wait before cutting (Dry Time) with VersaWorks. The drying time
varies according to the media.

 RELATED LINKS 

・  P. 54Setting the Dry Time

Cutting / Printing and Cutting
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Adjusting Cropping and Cutting

Depending on the composition of the media, the positioning of printing and cutting may be misaligned
even when you are using crop marks. Make corrections for misaligned printing and cutting for the media
you are using.

When making these adjustments, use adhesive media that can be cut.

MEMO

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. Click [CropCut Adjustment].

3. Click [Print and Cut Pattern].

A test pattern is printed.

Performing Printing and Cutting Separately
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4. Follow the on-screen instructions and enter the values for [New Scanning Value] and [New Feeding Val-
ue].

5. Click [Apply].

The values in [New Scanning Value] and [New Feeding Value] change to "0."

6. Click [Close].

Performing Printing and Cutting Separately
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Printing with Crop Marks Followed by Cutting

With this machine, you can print with crop marks, and then reload this media and cut it.

(Example: Perform lamination or other processing after printing, then reload the media and perform cut-
ting.)

In this situation, carry out alignment to prevent misalignment of the printing results and the cutting lines.
Refer to [Performing cutting]>[Print laminate and cut] in the [VersaWorks Help] and perform the follow-
ing procedure.

Procedure

1. Print with crop marks.

2. Print with crop marks, remove the media, and then reload it.

Points for Media Setting

Place the crop marks ( ) on the blade protector ( ).

Ensure that the angle is less than 5 degrees. Failing to do so will make alignment impossible.

3. Align to the printed crop marks and perform cutting.

P. 33Step 5: Starting Print Output

 RELATED LINKS 

Performing Printing and Cutting Separately
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・ VersaWorks Help

Performing Printing and Cutting Separately
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Media Sizes Allowing Automatic Crop Mark Detection

Pinch roller

Crop mark

A 65 mm (2.56 in.) or more

B 22.5 mm (0.89 in.)

C 1.4 mm (0.06 in.)

D 60 mm (2.37 in.) or more

Performing Printing and Cutting Separately
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Performing Various Adjustments Through a Sequence of Operations

You can perform various output adjustments through a sequence of operations by clicking [Adjust All] on
the [Adjustment] tab. The adjustment method is the same as when adjusting settings individually.

Click [Adjust All] to display the screen shown in this figure.

[Next]: Continues to the screen for the adjustment currently displayed on the screen.

[Skip]: Skips the adjustment currently displayed on the screen.

[Cancel]: Cancels the adjustment process.

The adjustments vary depending on the output method. Refer to the table below.

Printing (Only) Cutting (Only) Printing and Cutting Crop-Cut

Check Nozzle Condition ✓ - ✓ ✓

Bidirectional adjust-
ment*1 ✓ - ✓ ✓

Calibrate Sheet Feeding ✓ ✓ ✓ ✓

Cut Adjustment - ✓ ✓ ✓

Print and Cut Adjust-
ment - - ✓ ✓

CropCut Adjustment - - - ✓

 

*1 This is available when bidirectional printing is set in the BN-20D driver or VersaWorks.
 

 RELATED LINKS 

・  P. 29Printing Tests and Normal Cleaning

・  P. 27Bidirectional Adjustment

Utility : Other Function
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・  P. 31Correcting the Media Feed

・  P. 40Adjusting Cutting

・  P. 43Printing and Cutting Adjustment

・  P. 47Adjusting Cropping and Cutting

Utility : Other Function
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Setting the Dry Time

You can set the time that the printer waits from the completion of the printing and cutting of one job to
the starting of the printing and cutting of the next job.

Especially in the case of printing and cutting, it is recommended to set a time that allows the ink to be
sufficiently dried before cutting is started.

For information on the setting method, refer to [VersaWorks Help].

Note that when you set the dry time in VersaWorks, if [Use Printer Settings] is selected, the dry time is set to "0."

IMPORTANT

 RELATED LINKS 

・ VersaWorks Help

Utility : Other Function

54  Optimizing the Output Quality

https://downloadcenter.rolanddg.com/VersaWorks6


Resetting All Adjustments to Factory Default Values

Click [Factory Reset] on the [Option] tab of Utility to reset all the Utility settings to their factory default
values.

When you click [Factory Reset], the message shown in the figure is displayed. Click [Yes] to reset the set-
tings.

Utility : Other Function
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Automatic Maintenance Function: Points to Note

This machine has a function to automatically perform periodical maintenance tasks, e.g. to prevent the
print heads from drying out. To ensure the maintenance is properly carried out, please observe the follow-
ing points:

• Make sure that the main power is on at all times.

• Do not leave the front cover and maintenance cover open.

Keep Performing Maintenance

Daily maintenance

To keep this machine in tip-top condition, make sure that daily maintenance is actually performed every
day.

Periodic maintenance

To maintain reliable output conditions, some maintenance tasks need to be carried out at least once a
month.

Switch the power on at least once every week

Switch the sub power on at least once every week. When you turn on the power, the machine automati-
cally performs operations such as those to keep the print heads from drying out. Leaving the machine
unused for a prolonged period may damage the print heads, so be sure to switch on the power to per-
form these automatic operations.

Keep the machine at a constant temperature and relative humidity.

Even when the machine is not in use, keep it at a temperature of 5 to 40°C (41 to 104°F) and a relative
humidity of 20 to 80% RH (with no condensation). Failure to do so may result in malfunction.

 RELATED LINKS 

・  P. 64Daily Maintenance

・  P. 69Periodical Cleaning Maintenance

When Not in Use for a Prolonged Period

In advance, insert ink cartridges that have a large amount of ink remaining.

If the ink runs out, the machine will not be able to periodically perform automatic maintenance. If the
machine is left in this state, the print heads may malfunction. If you know that you will not use the
machine for a prolonged period, insert ink cartridges that have a large amount of ink remaining.

Replace the waste cartridge in advance of prolonged periods of disuse.

If you know that you will not use the machine for a prolonged period, follow the procedure below to
replace the drain cartridge. For information about purchasing drain cartridges, contact your authorized
Roland DG Corp. dealer.

Do not reuse drain cartridges. Doing so makes it impossible to manage the amount of discharged fluid, which may over-
flow.

IMPORTANT

Important Notes on Handling and Use
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 RELATED LINKS 

・  P. 66Replacing the Waste Cartridge

Important Notes on Handling and Use
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Checking for Remaining Ink

Ink levels can be checked in the Ink tab of the Utility window. A simple bar scale indicates the level of ink
in each cartridge. Percentage values also indicate the level of ink remaining. When the ink cartridge is re-
moved, "No Cartridge" is displayed.

• WT: White

• MG: Magenta

• CY: Cyan

• YE: Yellow

• BK: Black

* The display shows approximately how much ink remains. It may differ somewhat from the actual amount
remaining.

When an ink level is low, a message appears on the Utility icon in the notification area. Check the ink that
is running out in the Utility window and prepare a relevant cartridge for replacement.

Checking Ink Levels and Replacing
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How to Replace the Ink Cartridge

When ink runs out, a warning beep sounds and printing pauses. Pull out the empty cartridge and insert a
new one. Printing resumes.

The precipitation of the ingredients in the ink disables printing in normal color. So that the ink mixes well, shake each
ink cartridge 50 times (about 20 seconds) horizontally with a stroke length of around 5 cm (1.97 in.) from each end of
the ink cartridge before inserting it.

IMPORTANT

Important notes on replacing cartridges

• Replace the cartridge with an item of identical type and color.

• Insert the cartridge so that the side with the arrow faces up.
• Insert and remove cartridges slowly, one at a time.
• Insert the cartridge firmly, as far as it will go.

• Never mix different types of items.
• Never leave the machine with an ink cartridge removed. The print heads may become clogged.
• Never insert or remove a partially used ink cartridge with undue force.
• Never remove an ink cartridge suddenly while the printer is in operation.

IMPORTANT

Never store ink, cleaning liquid, or discharged fluid in any of the following locations.

• Any location exposed to open flame

WARNING

Checking Ink Levels and Replacing
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• Any location where high temperature may occur

• Near bleach or any other such oxidizing agent or explosive material

• Any location within the reach of children
Fire may be a danger. Accidental ingestion by children may pose a health hazard.

Checking Ink Levels and Replacing
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Maintenance of Ink Cartridges

The ink ingredients have a tendency to separate and settle. Allowing the ink to stand can cause the settled
material to harden, resulting in malfunction or other problems.

So that the ink mixes well, periodically shake each ink cartridge 50 times (about 20 seconds) horizontally
with a stroke length of around 5 cm (1.97 in.) from each end of the ink cartridge before reinserting it.

Cleaning

Never use gasoline, alcohol, thinner, or any other flammable material.
Doing so may cause a fire.

WARNING

Wipe away any ink or grime on the media path and other areas as part of the daily cleaning procedure.
Pinch rollers, grit rollers, and the platen are particularly prone to the buildup of grime. Wipe away any
buildup of ink or grime on the media path. Clean by wiping with a cloth moistened by neutral detergent
diluted with water then wrung dry.

• This machine is a precision device and is sensitive to dust and dirt. Perform cleaning on a daily basis.
• Never attempt to oil or lubricate the machine.

MEMO

Daily Maintenance
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Grit roller Remove buildup of media scraps and other material using a brush. Never
use a metal brush.

Pinch roller Periodically wipe away any grime. Failure to clean this part properly may
result in the transfer of grime to the surface of media.

Platen Wipe away any buildup of ink or grime on the media path.

Daily Maintenance
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Replacing the Waste Cartridge

When the waste cartridge is filled with waste fluid, the Utility window automatically opens and displays a
message in the Status column that prompts the replacement of the cartridge. Follow the message's instruc-
tions and prepare a replacement waste cartridge or replace the cartridge.

Before you remove the drain cartridge, wait for a message to be displayed in the utility.
Failing to follow this procedure may cause discharged fluid to flow out of the tube and spill, soiling your hands or the
floor.

CAUTION

If you know that you will not use the machine for a prolonged period, follow the procedure below to re-
place the drain cartridge.

Never place the drain cartridge or ink near an open flame.
Doing so may cause a fire.

WARNING

Do not open the lid on the drain cartridge.
Any spillage or vapor leakage may cause fire, odor, or physical distress.

CAUTION

Procedure

1. Remove the drain cartridge.

2. Insert a new drain cartridge.

Daily Maintenance
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3. When the dialog box shown below is displayed, click [Yes] .

Do not reuse drain cartridges.
Doing so makes it impossible to manage the amount of discharged fluid, which may overflow.

IMPORTANT

Dispose of discharged fluid properly, in accordance with the laws in effect in your locale.Discharged fluid is
flammable and contains toxic ingredients. Never attempt to incinerate discharged fluid or discard it with ordi-
nary trash. Also, do not dispose of it in sewer systems, rivers, or streams. Doing so may have an adverse im-
pact on the environment.

IMPORTANT

To purchase a waste cartridge, contact your authorized dealer or Roland DG.

Daily Maintenance
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Care and Maintenance of the Print Heads

To ensure optimum printing, the print heads need to be maintained in good condition. There are two kinds
of maintenance: daily maintenance and periodical maintenance.

Daily care and maintenance

Normal Cleaning

We recommend performing Normal Cleaning everyday before the start of operations.
P. 29Step 3: Printing Tests and Normal Cleaning

Periodical care and maintenance

P. 69Periodical Cleaning Maintenance

* Print heads are consumable parts and subject to wear. Depending on the frequency of use, periodical re-
placement is required. Please order them directly from us or your authorized Roland DG Corp. dealer.

Daily Maintenance
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Periodic Cleaning Menus

This machine has several cleaning menus. Perform the appropriate level of cleaning in accordance with the
ink type, the cleaning period, and the machine condition.

Periodical Cleaning Maintenance
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Medium/Powerful Cleaning

If problems such as nozzle drop-out persist even after you have performed normal cleaning, carry out the
more powerful [Medium Cleaning] two or three times. If this still does not resolve the problem, carry out
the even more forceful [Powerful Cleaning].

Medium cleaning consumes more ink than normal cleaning. Powerful cleaning consumes more ink than medium clean-
ing. Because the print heads are prone to damage if cleaned too frequently, do not perform cleaning more than neces-
sary.

MEMO

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. On the [Adjustment] tab, select [Medium Cleaning] and click [Go].

3. Click [Check Nozzle Condition].

Periodical Cleaning Maintenance
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4. Click [Test Print].

A test pattern is printed. Follow the on-screen instructions to check for nozzle drop-out.

• Nozzle drop-out is present. -> Proceed to step 5.

• No nozzle drop-out is present. -> Click [Close] to finish the procedure.

5. Select the [Medium Cleaning], and then click [Go].

Medium cleaning starts.

6. Check for nozzle drop-out again.

If nozzle drop-out is not fixed by [Medium Cleaning], perform [Powerful Cleaning].

If problems such as dot drop-out persist even after you have performed powerful cleaning several times, per-
form [Manual Cleaning].

MEMO

 RELATED LINKS 

・  P. 72Manual Cleaning
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When Manual Cleaning Is Necessary

The timing with which manual head cleaning is required varies depending on the type of ink you are using.
Be sure to perform this cleaning with the required timing.

P. 69Periodic Cleaning Menus

Manual cleaning is recommended when the following symptoms occur.

When any of the following symptoms occur and cannot be solved by automatic cleaning functions such as
normal cleaning, perform manual cleaning.

Wiper replacement may also be effective in improving these symptoms.

Nozzle drop-out Ink drips Dragging dirt

Dust or other foreign matter adheres to
the print heads and impedes correct ink
discharge.

Ink pools in dust or dirt adhered to the
print heads, and drips onto the media.

The phenomenon where dirt or dust accu-
mulates on the print heads.

• When the cleaning stick and cleaning liquid used for manual cleaning runs out, purchase them from your authorized
dealer.

• The print heads are components that wear out. Periodic replacement is required, with the frequency of replacement
depending on use. Contact your authorized dealer.

MEMO

 RELATED LINKS 

・  P. 79Replacing the Wiper
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Manual Cleaning Method

Important notes on this procedure

• Before attempting this operation, remove any media.
• To prevent the heads from drying out, finish this procedure in 10 minutes or less. A warning beep sounds after 10

minutes.
• Never use any implements other than the included cleaning sticks. Cotton swabs or other lint-producing items may

damage the heads. If you use up the cleaning sticks, contact your authorized dealer.
• Use one cleaning stick per cleaning session, and then discard the stick after use. Reusing cleaning sticks may reduce

print quality.
• Do not put a cleaning stick that has been used for cleaning into the cleaning liquid. Doing so will deteriorate the

cleaning liquid.
• Never rub the nozzle surface of the heads.
• Stroke the sponges very gently, applying as little pressure as possible. Never rub, scrape, or crush them.

IMPORTANT

When a warning beep sounds during cleaning
To prevent the print heads from drying out, an alarm sounds about 10 minutes after the start of the operation. Perform
the operation by following the message displayed in the Utility window.

IMPORTANT

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.
https://youtu.be/1eLWD9uPrR0

MEMO

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. On the [Adjustment] tab, click [Manual Cleaning].

Manual Cleaning
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The manual cleaning procedure is displayed. Carefully read the on-screen instructions and carry
out the work.

3. Perform a printing test to check the results.

Perform cleaning using the machine's cleaning feature several times when necessary.

If nozzle drop-out occurs in two or three locations after cleaning, the output quality will not be affected.
Print the actual printing data and use the machine as-is if you can confirm that there are no problems.

MEMO

 RELATED LINKS 

・  P. 29Printing Tests and Normal Cleaning
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Replacing the Blade

If the blade becomes dull, if the edge of the blade is chipped, or if the cutting quality is lowered, replace
the blade with a new blade.

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Never touch the tip of the knife.
Doing so may result in injury. The cutting performance of the blade will also be impaired.

CAUTION

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. On the [Replace Tools] tab, click [Replace Tools].

When the screen shown in the figure appears, open the front cover and replace the blade.

3. Remove the blade holder.

Replacing Parts for Maintenance

76  Replacing Consumable Parts



4. Replace the blade.

(1) Press the pin (A).

(2) Remove the old blade (B).

(3) Install a new blade (C).

5. Support the screw from below and insert the blade holder.

Failure to do this may adversely affect the cutting quality.

6. Tighten the screw.

Tug the blade holder upward to make sure it does not come loose.

Replacing Parts for Maintenance
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7. Close the front cover.

Click [Close].

This completes the replacement procedure.

8. Make adjustments for cutting.

 RELATED LINKS 

・  P. 40Adjusting Cutting
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Replacing the Wiper

The wiper is a component that is used for cleaning the print heads. When the message appears on the Util-
ity icon in the computer's notification area, it is time to replace the wiper with a new one. Replace with
new items. For information about purchasing wipers, contact your authorized dealer.

When the warning alarm sounds during wiper replacement
To prevent the print heads from drying out, an alarm sounds about 30 minutes after the start of the operation. Perform
the operation by following the message displayed in the Utility window.

IMPORTANT

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. On the [Replace Tools] tab, click [Replace Wiper].

A procedure for replacing the wiper is displayed. Carefully read the on-screen instructions and car-
ry out the work.

Replacing Parts for Maintenance
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3. When the operation is completed, close the front cover.

Replacing Parts for Maintenance
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Replacing the Felt Wiper

The felt wiper is a component that is used for cleaning the print heads. When the message appears on the
Utility icon in the computer's notification area, it is time to replace the wiper with a new one. Replace
with new items. For information about purchasing felt wipers, contact your authorized dealer.

When the warning alarm sounds during felt wiper replacement
To prevent the print heads from drying out, an alarm sounds about 30 minutes after the start of the operation. Perform
the operation by following the message displayed in the Utility window.

IMPORTANT

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. On the [Replace Tools] tab, click [Replace Felt Wiper].

A procedure for replacing the felt wiper is displayed. Carefully read the on-screen instructions and
carry out the work.

Replacing Parts for Maintenance
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3. When the operation is completed, close the front cover.

Replacing Parts for Maintenance

82  Replacing Consumable Parts



Replacing the Cap Top

The cap top is a part that prevents ink clogging due to the print heads drying out. The cap top sticks close
to the print head surface and sucks out the ink, thereby preventing the print heads from drying out.

To maintain stable printing at all times, replace the cap top once every 6 months.

For information about purchasing cap tops, contact your authorized dealer.

When the warning alarm sounds during cap top replacement
During this operation, the print heads may dry out, leading to print head failure. Therefore, complete the cap top re-
placement within 30 minutes.

IMPORTANT

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Depending on this machine's installation environment, the work location may be shadowed, making the cap top difficult
to see. In this situation, it is recommended that you shine light on the cap top to allow the replacement work to pro-
ceed smoothly.

MEMO

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.
https://youtu.be/1eU9UKVuMSo

MEMO

Required items

Protective eyewear Gloves Light

Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. On the [Replace Tools] tab, click [Replace Cap Top].

Replacing Parts for Maintenance
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A procedure for replacing the cap top is displayed. Carefully read the on-screen instructions and
carry out the work.

3. When the operation is completed, close the front cover.

Replacing Parts for Maintenance
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Do the print heads show nozzle clogging?

Carry out a printing test and make sure no nozzle clogging occurs. If nozzle clogging is present, perform
head cleaning.

 RELATED LINKS 

・  P. 29Printing Tests and Normal Cleaning

・  P. 70Medium/Powerful Cleaning

・  P. 72Manual Cleaning

Have you carried out[Calibrate Sheet Feeding] ?

Large misalignment in the amount of feed of the media may result in printing that seems coarse or con-
tains horizontal stripes. We recommend performing [Calibrate Sheet Feeding] before daily operations and
when changing the media type.

 RELATED LINKS 

・  P. 31Correcting the Media Feed

Have you carried out [Bidirectional adjustment] ?

We recommend performing [Bidirectional adjustment] before daily operations and when changing the me-
dia type. The optimal adjustment value may vary, depending mainly on the thickness of the media.

 RELATED LINKS 

・  P. 27Bidirectional Adjustment

Is the temperature of the room too low?

The heater may not warm up sufficiently when the ambient temperature is less than 20°C (68°F). Also,
even when the heater warms up, an adequate effect may not be obtained if the media is thoroughly chil-
led. Before printing, allow the media to come to room temperature.

Is the printer installed in a level and stable location?

Never install the machine in a location where it is tilted or where it may wobble or experience vibration.
Also make sure that the print heads are not exposed to moving air.

Is the printer installed in a location out of direct sunlight?

Never install in a location exposed to direct sunlight.

Is the media loaded and set up correctly?

If the media is not loaded and set up correctly, printing may be adversely affected. Make sure the media is
loaded and set up correctly.

Printed results are coarse or contain horizontal
stripes
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 RELATED LINKS 

・  P. 93Media Feed Problems

Printed results are coarse or contain horizontal stripes
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Did you shake the ink cartridges gently before installing them?

Shake new cartridges gently before you install them. So that the ink mixes well, periodically shake each
ink cartridge 50 times (about 20 seconds) horizontally with a stroke length of around 5 cm (1.97 in.) from
each end of the ink cartridge before reinserting it.

Is the media wrinkled?

If the media is wrinkled and comes loose from the platen, colors may be uneven or printing quality may
suffer.

 RELATED LINKS 

・  P. 93Media Feed Problems

Is the printer installed in a level and stable location?

Never install the machine in a location where it is tilted or where it may wobble or experience vibration.
Also, make sure that the print heads are not exposed to circulating air. These factors may lead to nozzle
clogging or reduced printing quality.

Is the printer being used in a location subject to severe changes in the operat-
ing environment?

Large fluctuations in temperature or humidity while printing is in progress may cause the colors to change
partway through. When you're performing printing, use the machine in a location where temperature and
humidity are stable.

Colors are unstable or uneven
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Are the print heads dirty?

The following may cause ink to drip on the media during printing.

• Buildup of fibrous dust (lint) around the heads.

• Ink transferred to the heads due to rubbing against the media.

If this happens, perform manual head cleaning. We recommend carrying out periodic print heads
cleaning.

• Too Low Humidity.

• Use this machine in the environment of 35 to 80 %RH (non condensation).

 RELATED LINKS 

・  P. 69Periodical Cleaning Maintenance

The media becomes soiled when printed
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Is the media loaded and set up correctly?

If the media is not loaded and set up correctly, or media feed is not smooth, cutting may be adversely
affected. Make sure the media is loaded and set up correctly.

 RELATED LINKS 

・  P. 93Media Feed Problems

Are the settings for the cutting conditions appropriate?

Misalignment or skewing may occur if the cutting speed is too fast or the blade force is too high. Try
changing the cutting conditions. With media having a strong adhesive layer, the adhesive layer reattaches
to itself immediately after cutting. However, if a cutting test shows that the peeling of the media and the
blade traces on the backing paper are optimal, then the media is being cut properly. Be careful not to
make the blade force too high.

 RELATED LINKS 

・  P. 40Adjusting Cutting

・  P. 42Accurately Adjusting the Cutting-in Amount

Is the length of output too long?

For printing & cutting in particular, the longer the page length (that is, the longer the distance the media
is returned after printing), the greater is the chance of misalignment occurring. It is a good idea to keep
the size of each single page to the minimum necessary.

Are you using media that exhibits large expansion and contraction?

When you're performing printing & cutting, misalignment occurs if the media expands or contracts. If this
happens, try performing printing with crop marks, then setting the base point and one or more align points
and performing cutting. This corrects for expansion and contraction of the media.

 RELATED LINKS 

・  P. 47Performing Printing and Cutting Separately

Cutting is misaligned or skewed
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Does the tip of the blade holder cap scrap the printed surface?

The tip of the blade holder cap may scrape, and soil or damage the printed surface. If this happens, in-
crease the amount of blade extension.

 RELATED LINKS 

・  P. 42Accurately Adjusting the Cutting-in Amount

The printed surface is damaged when cutting
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If an error message is displayed because the media has jammed, immediately correct the problem. Failure
to do so may damage the print heads.

 RELATED LINKS 

・  P. 110Error Messages

Is the media warped or wrinkled?

Many factors can cause warping or wrinkling. Refer to the following and correct the problem.

 RELATED LINKS 

・  P. 93Media Feed Problems

The Media Jams
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Is the media loaded and set up straight and securely?

Feed is not smooth when the media is not straight or is tensioned unevenly on the left and right. Reload
the media.

 RELATED LINKS 

・  P. 20Loading Media

Was loaded media allowed to stand for some time?

Media may shrink or wrinkle if it is heated for an extended time. When printing ends, press and hold down
the [POWER] key to switch off the sub power or remove the media.

Was the media loaded while the heater was hot?

Loading media after the heater has warmed up causes the temperature of the media to rise suddenly,
which may cause the media to shrink or wrinkle during printing. Before loading media, switch off the sub
power and allow the platen to cool.

Is the temperature of room too low?

Use this machine in an environment having an ambient temperature of 20 to 32°C (68 to 90°F). If the ma-
chine is used at an ambient temperature less than 20°C, then depending on the type or width of the me-
dia, wrinkling or temperature-caused unevenness may occur. To obtain stable printing results, the machine
should be used at an ambient temperature of 20 to 32°C (68 to 90°F).

Is the humidity of the room too high?

Use this machine in the environment of 35 to 80 %RH (non condensation).

Is the using media deflected?

If using the deflected media, it cause winkle of the media.

Media Wrinkles or Shrinks
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Is the media loaded and set up straight and securely?

Feed is not smooth when the media is not straight or is tensioned unevenly on the left and right. Reload
the media.

 RELATED LINKS 

・  P. 20Loading Media

Media Feed Is Not Straight
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Do the media strike some other object?

Make sure the media do not touch anything else. This may affect output, even when feed appears to be
smoothly.

 RELATED LINKS 

・  P. 20Loading Media

Is the media too thick?

Media that is too thick may not only cause unstable feed, but may scrape the print heads, resulting in mal-
function. Never use such media.

Are the grit rollers dirty?

Check to make sure the grit rollers are free of buildup of foreign material such as media scraps.

 RELATED LINKS 

・  P. 64Cleaning

Media Feed Is Not Smooth
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If the print-head carriage stops over the platen, take action immediately to prevent the heads from drying
out.

What to Do First

Hold down the [POWER] key for one second or longer to switch the sub power off, then back on. If the
media is jammed, then also remove the media.

If the print-head carriage move to the standby position (on the right side of the machine), it means the
operation has ended successfully.

If The Heads Still Do Not Move
Try switching off the main power, then again switching on the main power, followed by the sub power.

If the print-head carriage move to the standby

If the heads still do not move after "What to Do First" is performed, carry out the following emergency
response measure, then contact your authorized Roland DG Corp. dealer.

Procedure

1. Switch off the main power and open the front cover.

2. Gently move the print heads to the standby position.

Stopping at the place where the audible click is heard locks the print heads in place.

The Print Heads Stop Moving
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3. Gently apply pressure from the right side to make sure the print heads don't move to the left.

If the print heads move to the left, again move them slowly by applying pressure from the left side
and make sure they lock in place.

The Print Heads Stop Moving
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Is the power switched on?

Switch on the printer's main power, then press the [POWER] key and make sure the key lights up.

Does the [POWER] key stay steadily lighted?

Output is not performed when [POWER] key does not stay steadily lighted. After the media is loaded, pull
the loading lever.

Is the [POWER] key flashing?

When the [POWER] key flashes, no operation except for canceling output is accepted.

Is the cover open?

Close front cover, and maintenance cover.

Has ink run out?

If you send the output data in a state where there is no ink left, a warning buzzer will sound and the ma-
chine will stop temporality. A message indicating that ink has run out is displayed in the Status field of
Utilities. When the ink cartridge is replaced with a new one, printing or cutting starts.

 RELATED LINKS 

・  P. 61How to Replace the Ink Cartridge

・  P. 110Error Messages

Is a message displayed on the Utility icon in the task tray or in the Utility win-
dow?

 RELATED LINKS 

・  P. 108Messages

・  P. 110Error Messages

Are the cables connected?

Connect the cables securely.

 RELATED LINKS 

・ BN-20D Installation Guide

The Printer Unit Doesn't Run
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Is the driver installed correctly?

If the connection to the computer is not made in the described sequence, the driver may not be installed
correctly. Utility does not function normally when the driver is misconfigured. Check again to ensure that
the connection was made using the correct procedure.

 RELATED LINKS 

・ BN-20D Installation Guide

Are two or more machines connected to a single computer?

The utility cannot control more than one machine at the same time. Never connect two or more instances
of this machine to a single computer.

Is the temperature of the room too low?

This machine does not complete startup until the heater reaches the specified temperature, and does not
accept any operation. When the ambient temperature is low, the heater is slow to warm up. Use the ma-
chine in an environment where the temperature is 20 to 32 °C (68 to 90 °F).

Did you forcibly remove any detachable external storage devices connected by
USB?

When you remove the USB removable device (USB flash drive, USB hard disk, etc.), you must run [Safely
Remove Hardware and Eject Media] or [Eject] before detaching it. If you remove the USB device while
the BN-20D is printing without having first performed one of these operations, the printing may be abort-
ed.

The Printer Unit Doesn't Run
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If you have canceled installation or if the installation wizard does not appear when the USB cable is con-
nected, follow the procedure below.

Windows 11

Procedure

1. Connect the machine and the computer with the USB cable, and switch on the machine.

2. If the [Found New Hardware] message appears, click [Cancel] to close it.

3. Right-click the Start menu, and then click [Device Manager].

When the [User Account Control] window appears, click [Continue]. The [Device Manager] win-
dow appears.

4. From the [View] menu, click [Show hidden devices].

5. Search the list for [Printers] or [Other devices], and then double-click it.

The name of your machine or [Unknown device] appears below the selected item. Click the name
to select it.

6. From the [Action] menu, click [Uninstall device].

7. In the [Confirm Device Uninstall] window, click [OK].

8. Close the [Device Manager].

9. Disconnect the USB cable from the computer, and restart Windows.

10. Uninstall the driver according to the procedure below.

P. 106Uninstalling the Driver

11. Refer to the "Installation and Initial Settings" to redo the installation from the beginning.

 RELATED LINKS 

・ BN-20D Installation and Initial Settings

The Driver cannot be Installed
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Windows 10

Procedure

1. Connect the machine and the computer with the USB cable, and switch on the machine.

2. If the [Found New Hardware] message appears, click [Cancel] to close it.

3. Right-click the Start menu, and then click [Device Manager].

When the [User Account Control] window appears, click [Continue]. The [Device Manager] win-
dow appears.

4. From the [View] menu, click [Show hidden devices].

5. Search the list for [Printers] or [Other devices], and then double-click it.

The name of your machine or [Unknown device] appears below the selected item. Click the name
to select it.

6. From the [Action] menu, click [Uninstall device].

7. In the [Confirm Device Uninstall] window, click [OK].

8. Close the [Device Manager].

9. Disconnect the USB cable from the computer, and restart Windows.

10. Uninstall the driver according to the procedure below.

P. 106Uninstalling the Driver

11. Refer to the "Installation and Initial Settings" to redo the installation from the beginning.

 RELATED LINKS 

・ BN-20D Installation and Initial Settings

The Driver cannot be Installed
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To uninstall the driver, follow the procedure below.

If the driver is uninstalled using a method other than the procedure given below, it might be impossible to reinstall the
driver.

IMPORTANT

Windows 11

Procedure

1. Switch off the machine, and disconnect the connector cable between the computer and the machine.

2. Log on to Windows as an administrator.

3. Right-click the Start menu, and then click [Apps and Features].

4. Select the driver of the machine you want to delete by clicking it, and then click [Uninstall].

5. A message prompting you to confirm deletion appears. Click [Yes].

Windows 10

Procedure

1. Switch off the machine, and disconnect the connector cable between the computer and the machine.

2. Log on to Windows as an administrator.

3. Right-click the Start menu, and then click [Apps and Features].

4. Select the driver of the machine you want to delete by clicking it, and then click [Uninstall].

5. A message prompting you to confirm deletion appears. Click [Yes].

Uninstalling the Driver
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These are the main messages that appear in the Utility window to prompt correct operation. They do not
indicate any error. There are other messages that appear in the Utility window. Follow the displayed
prompts and take action accordingly.

[XX ink : Shake the cartridge well]

Remove the ink cartridge that is indicated in *** and shake it well.

 RELATED LINKS 

・  P. 64Maintenance of Ink Cartridges

[The Waste cartridge is full.]

The waste cartridge is full. Replace the waste cartridge with a new one.

 RELATED LINKS 

・  P. 66Replacing the Waste Cartridge

[Replace the wiper.]

It is time to replace the wipers. Replace the wipers.

 RELATED LINKS 

・  P. 79Replacing the Wiper

[Replace the felt wiper.]

It is time to replace the felt wiper. Replace the felt wiper.

 RELATED LINKS 

・  P. 81Replacing the Felt Wiper

[The connection to the printer has been released.]

A USB cable that connects this machine and the computer is unplugged, or the main power of this machine
is switched off. If the machine is allowed to stand with the main power switched off, the automatic main-
tenance fails to work and it may cause a machine malfunction. Make sure that the main power is on at all
times.

[Clean the printer manually.]

If [Clean the printer manually.] message is displayed on the screen of the computer connected to the
printer, be sure to perform manual cleaning.

 RELATED LINKS 

Messages
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・  P. 72Manual Cleaning

Messages
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This section describes the error messages that may appear in the Utility window and how to take action to
remedy the problem. In addition to the messages described below, the Utility window shows the causes of
errors and troubleshooting information. If the troubleshooting information displayed in the Utility window
or action described here does not correct the problem or if an error message not described here appears,
contact your authorized dealer.

[The pinch roller position is incorrect.]

The media size is not acceptable for this machine, and thus the pinch roller position is incorrect.

If the pinch roller position is incorrect, the media cannot be secured properly. Specific media sizes can be positioned properly with
the pinch rollers on this machine.

 RELATED LINKS 

・  P. 14Usable Media

[Crop marks could not be printed. Output will be canceled.]

The size of the data including the crop marks is larger than the printing or cutting area of the loaded me-
dia.

Make the printing or cutting area wider, such as by replacing the media with a larger piece of media or by changing the positions of
the pinch rollers, then send the data again.

The size of the data being output is too small.

Make the scanning-direction (the direction in which the print heads move) size of the data to at least 65 mm (2.56 in.). Change the
size of the data, and then send the data again. There is no limitation on the size of the data in the media-feed direction.

 RELATED LINKS 

・  P. 47Performing Printing and Cutting Separately

[Crop mark detection could not be started.]/[Crop marks were not found. Out-
put will be canceled.]

Automatic detection of crop marks could not be accomplished.

Load the media at the correct position and perform detection of crop marks again. If repeating automatic crop-mark detection re-
sults in an error again, change the type of media. Depending on the media, it may not be possible to detect crop marks automati-
cally.

 RELATED LINKS 

・  P. 47Performing Printing and Cutting Separately

・  P. 47Adjusting Cropping and Cutting

Error Messages
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[The operation has been stopped to prevent the print heads from drying out.
Turn the printer off.]

The print heads were forced to standby position to prevent them from drying out

Operation cannot be continued. Switch the sub power off, and then back on. Opening the front cover while output is in progress
causes an emergency stop. Never allow the print heads to remain in this state.

[Motor error]

A motor error occurred

Operation cannot be continued. By following the messages displayed in the Utility window, remove the media, close the front cover,
and then hold down the [POWER] key to switch the sub power off.
This error may be caused by factors including the following:

• The media has been set incorrectly
• The media has jammed.
• An operation that pulled the media with excessive force was performed.
Eliminate the case of the error before switching the sub power on, and then reload the media.

[Waste cartridge is estimated to be full]

Operation was stopped because the waste cartridge is full.

Operation cannot be resumed without correcting this error. Replace the waste cartridge with a new one by following the message
displayed in the Utility window. If a new waste cartridge is not available for immediate replacement, switch the main power off.

[Temperature error]

The temperature of the location where the machine is installed has risen above or fallen below the ambient
temperature at which the machine can operate.

Operation cannot be continued. Turn off the sub power. Bring the installed location to a temperature at which operation is possible
(20 to 32°C [68 to 90°F]), allow the machine to come to room temperature, and then turn on the power.

[Cover open error.]

Output was stopped because the front cover or maintenance cover is open.

Close the cover, and then start output again.

[Sheet setup error]

Setup of the media has failed.

Load the media correctly.

 RELATED LINKS 

・  P. 20Loading Media

Error Messages
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[Data error]

Output was stopped because a problem was found in the data received.

Operation cannot be continued. Check whether or not there is an error in the data. Check for a problem with the connector cable
or the computer, and then start output again.

[Ink has run out.]

Output was stopped because ink has run out.

On the [Ink] tab of the Utility window, check the color of the cartridge that has run out of ink, and then replace the ink cartridge
with a new one.

 RELATED LINKS 

・  P. 60Checking for Remaining Ink

・  P. 61How to Replace the Ink Cartridge

[Pinch lever was returned.]

Output was stopped because the loading lever was pushed backward while output was in progress.

Pushing the loading lever backward cancels the setup of the media, so output is stopped. Reload the media.

[No sheet is present.]

Output was attempted but failed because no media was present.

Load media.

[Printing cannot continue because the end of the sheet was detected. Printing
will be canceled.]

Printing was stopped because the trailing edge of the media was detected.

When the trailing edge of the media is detected, output is canceled.Load new media.

[ServiceCall No**]

An unrecoverable error occurred, or part replacement that must be performed by a service technician is
required

Note the number displayed on the display screen, and then switch off the main power. After you switch off the power, inform your
authorized dealer of the number that appeared on the display screen.

[Ink Cartridge error : *** ink cartridge ]

An ink cartridge that cannot be used was installed

Remove the ink cartridge of the indicated color to clear the error. Use an ink cartridge of the specified type. ("***" is the color of
the ink.)

Error Messages
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[BN-20D Utility is already running.]

An attempt was made to start Utility with it already running.

Utility is resident software that remains active even when it is not displayed on the screen. When it is not displayed, it is located in
the notification area in the lower-right corner of the computer's screen.

 RELATED LINKS 

・  P. 10Opening the Utility Window/Exiting Utility

[The cleaning liquid cartridge is empty. Replace the cleaning liquid cartridge
with a new one.]

Operation was stopped because the cleaning liquid cartridge is empty.

This message appears when operations such as "Head Wash" are in progress. Operation cannot be resumed without correcting this
error. Quickly replace the cleaning liquid with new cleaning liquid. Allowing the machine to stand with the empty cartridge may
result in a malfunction.

Error Messages

Handling Messages and Error Messages 113



Appendix

114



Operations When Moving the
Unit

Preparing to Move the Machine..................................................................... 116

Procedures from Preparing to Move to Reinstallation........................................... 117

Operations When Moving the Unit 115



To move the machine, you must completely drain all ink inside the machine and secure the print heads in
place with packing materials to protect them. Attempting to move the machine without first doing this
may result in damage to internal components due to leaking ink or damage to the print heads.

Required items

Unused cleaning cartridge (1) Dummy cartridges (4)

To purchase items that are sold separately, contact your authorized dealer.

Make sure to use a cleaning cartridge that corresponds to the ink type. Using the wrong cartridge may cause a machine
malfunction.

IMPORTANT

Preparing to Move the Machine
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Procedure

1. Open the Utility window.

P. 10Opening the Utility Window/Exiting Utility

2. On the [Option] tab, click [Head Wash].

Proceed with the work by following the on-screen instructions. Do not switch off the power until
the work is completed.

3. Move the machine as soon as possible.

4. Immediately reinstall the machine and fill with ink.

Refer to "Installation and Initial Settings" and promptly fill the machine with ink.

Important notes on moving

• Once the preparations for moving are complete, move the machine and fill it with ink with as little delay
as possible. Leaving the machine alone without ink may damage the print heads.

• When moving the machine, keep it at a temperature of 5˚C to 40˚C (41˚F to 104˚F) and at a humidity of
20%RH to 80%RH (with no condensation). Failure to do so may result in malfunction.

• Handle the machine with care when moving it, keeping it level (not tilted at an angle) and preventing it
from striking other objects.

IMPORTANT

Procedures from Preparing to Move to Reinstal-
lation
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Maximum Area

The printing or cutting area along the horizontal plane (the direction in which the carriages move) is de-
termined by the position of the pinch rollers.

Printing or cutting area

Left pinch roller

Right pinch roller

Printing or cutting coordinates origin (0,0)

A Max. 480 mm (18.89 in.)

B Max. 24,998 mm (984.2 in.)

C 5 mm (0.2 in.)

D 1.4 mm (0.06 in.)

Printing Area
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Maximum Area When Using Crop Marks

Printing or cutting area

Maximum area

Crop mark

A 12.5 mm (0.5 in.)

B 10 mm (0.4 in.)

Printing Area
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The cutting conditions and the service life of the blade change according to the media and the operating
environment, even when you're using identical blades. The service life also differs according to the type of
blade. A rough guide is shown below.

Blade Media Blade force Amount of blade offset
(amount of blade tip

correction)

Blade life (general
guide)*1

ZEC-U1005 General Signage Vinyl 50 to 150 gf 0.25 mm (0.01 in.) 8000 m (26,246.72 ft.)

ZEC-U5025 General Signage Vinyl
Fluorescent Vinyl
Fluorescent Vinyl

30 to 100 gf
120 to 200 gf
100 to 200 gf

0.25 mm (0.01 in.)
0.25 mm (0.01 in.)
0.25 mm (0.01 in.)

4000 m (13,123.36 ft.)
4000 m (13,123.36 ft.)
4000 m (13,123.36 ft.)

 

*1 The values for "Blade life" are estimates for when an identical type of material is used.
 

When uncut areas remain even when the blade force is increased to a value that is higher than the values shown in this
chart by 50 to 60 gf, replace the blade.

MEMO

About the Blade
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Unit: mm

Dimensional Drawing
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BN-20D

Printing technology Piezoelectric inkjet

Media Width*1 150 to 515 mm (5.9 to 20.3 in.)

Thickness Maximum 1.0 mm (39 mil) with liner, for printing
Maximum 0.4 mm (16 mil) with liner and 0.22 mm (9 mil) without liner, for
cutting

Roll outer diameter Maximum 150 mm (5.9 in.)

Roll weight Maximum 6 kg (13.2 lb.)

Core diameter 76.2 mm (3 in.) or 50.8 mm (2 in.)

Printing/cutting width*2 Maximum 480 mm (18.9 in.)

Ink cartridges Types 220-cc cartridge

Colors Five colors (cyan, magenta, yellow, black, and white)

Printing resolution (dots per inch) Maximum 1,440 dpi

Cutting blade Type Roland CAMM-1 series compatible

Blade offset 0.25 mm (9 mil)

Cutting speed 1 to 15 cm/s

Blade force 30 to 300 gf

Software resolution (when cutting) 0.025 mm/step

Distance accuracy (when printing)*4 Error of less than ±0.3% of distance traveled, or ±0.3 mm, whichever is great-
er

Distance accuracy (when cutting)*3*5 Error of less than ±0.4% of distance traveled, or ±0.3 mm, whichever is great-
er

Repeatability (when cutting)*3*6 ±0.1 mm or less

Alignment accuracy for printing and cutting*3*7 ±0.5 mm or less

Alignment accuracy for printing and cutting when
reloading media*3*8

Error of less than ±0.5% of distance traveled, or ±3 mm, whichever is greater

Print heater*9 Temperature: 35 °C (95 °F) (fixed)

Connectivity USB (compliant with Universal Serial Bus Specification Revision 2.0)

Power-saving function Automatic sleep feature

Power requirements AC 100 to 240 V ±10 %, 1.0 A, 50 / 60 Hz

Power consumption During operation Approx. 90 W

Sleep mode Approx. 5.5 W

Acoustic noise level During operation 62 dB (A) or less

During standby 42 dB (A) or less

Dimensions 1009 (W) x 582 (D) x 293 (H) mm (39.7 (W) x 22.9 (D) x 11.5 (H) in.)

Weight 36 kg (79.4 lb.)

Installation Environment Power on*10 Temperature: 20 to 32 °C (68 to 90 °F)
Humidity: 35 to 80 %RH (non-condensing)

Power off Temperature: 5 to 40 °C (41 to 104 °F)
Humidity: 20 to 80 %RH (non-condensing)

Accessories Power cord, USB cable, blade, blade holder, User's Manual, etc.

 

*1 It must be within the ranges shown below:

• 150 to 170 mm (5.9 to 6.7 inch)
• 200 to 235 mm (7.9 to 9.3 inch)
• 287 to 322 mm (11.3 to 12.7 inch)
• 348 to 383 mm (13.7 to 15.1 inch)

Specifications
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• 393 to 429 mm (15.5 to 16.9 inch)
• 439 to 474 mm (17.3 to 18.7 inch)
• 487 to 515 mm (19.2 to 20.3 inch)

*2 The length of printing or cutting is subject to the limitations of the program.

*3 • Media type: Media specified by Roland DG Corp.
• Temperature: 25 °C (77 °F), humidity: 50%
• Roll media must be loaded correctly.
• Front margin: 35 mm or more
• Excluding expansion/contraction of the media
• All correction or adjustment function of this machine has been made properly.

*4 With Roland PET film, print travel: 1 m

*5 Range for assured repetition accuracy: Length 1,000 mm

*6 Range for assured repetition accuracy : Length 1,000 mm

*7 • Provided that media length is under 1,000 mm
• Excludes the effects of slanted movement and of expansion and contraction of the media.

*8 • Data size : 1,000 mm in the media-feed direction, 480 mm in the carriage-movement direction
• No lamination
• Automatic detection of crop marks at 4 points when media is reloaded.
• Excluding possible shift caused by expansion/contraction of the media and/or by reloading the media.

*9 • Warm-up is required after power up. This may require 5 to 20 minutes, depending on the operating environment.
• Depending on the ambient temperature and media width, the temperature may fail to be reached 35 (°F).

*10 Operating environment
①: Use in an operating environment with this range.
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